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SECTION 1

1.1

1.2

INTRODUCTION

The aim of these Guidelines is to assist Services and employees in finding effective ways to
communicate with sensory disabled customers and minority ethnic customers whose first
language is not English.

In our contact with customers we need to identify the means of communication that is
appropriate to particular individuals and groups.

These Guidelines provide information about different communication needs and suggest
practical ways in which communication can be facilitated.

The Council’s Equal Opportunities Policy and Equality Scheme state our commitment to
equality and to ensuring access for all. These guidelines will assist us in achieving this and

in observing our duties under the Race Relations Amendment Act 2000, Disability
Discrimination Act 2005 and Equality Act 2006.

USING PLAIN LANGUAGE TO IMPROVE COMMUNICATIONS

Regardless of the language or format being used to communicate (e.g. Braille) the
principles remain the same. Listed below are some of the key principles, which always

apply:

¢ Before you communicate, ask yourself: who will be reading or hearing this? Make
your use of language relevant to the lives of people you are writing or talking to.

¢ Imagine you are talking to them face-to-face. What would you say? Write as you
would talk.

¢ Seck to inform, not to impress. Avoid using language offensive to particular groups.

¢ Keep your sentences short. Aim for a maximum of 20 words per sentence. Long
sentences have a greater chance of being ambiguous. Also, use short paragraphs
where possible.

¢ Use everyday words whenever you can.
¢ Use T, ‘we’ and ‘you’ wherever possible.

¢ Avoid the use of jargon. If you must use jargon or specialist terms, explain in plain
English what you mean. Even the most basic terminology may not be understood
(e.g. DOB does not signify Date of Birth to many people).

¢ Try and use active instead of passive verbs:

E.g. Your application will be considered (passive).
We will consider your application (active).



¢ Do not use block capitals, for example in headings. People recognise words by their
shape. Using block capitals adversely affects people with reading difficulties.

¢ Use ‘ragged right’ and not ‘full justify’ for text. Fully justified text on both sides
creates uneven spaces in text that makes it difficult to read.

¢ Aim for a friendly, informative tone. Do not sound threatening. Where necessary be
firm but polite.

Not using plain language can confuse or embarrass people. Language is very versatile and
you can always find words and phrases that are more familiar to your reader or listener.
Remember that you communicate to gain or impart information. Do not confuse your
reader/listener by using words they may not understand.

The terminology used in all communications should reflect the Council’s Equal
Opportunities Policy. Vocabulary, which excludes particular groups, should not be used
as this fails to convey the message of equal access and may also cause offence.

The use of language and terminology is often seen as trivial but plays an important part in
reflecting the values of the Council. The terminology used can also influence the way
individuals and groups view and make use of services.



SECTION 2

2.1

TRANSLATING AND INTERPRETING COMMUNITY LANGUAGES

2.1.1 General Information

In order to comply with the requirements of the Race Relations Act 2000 (Amendment)
and the Local Government, etc. (Scotland) Act 1994, the Council needs to communicate

effectively with minority ethnic communities in its area.

Ethnic minority communities within Falkirk Council area are small and scattered. The
principal languages spoken are Polish, Punjabi, Urdu and Chinese (Cantonese, Hakka and
Mandarin) although at any one time there may be around thirty different languages other
than English spoken by residents or visitors to the area.

Punjabi speakers from India will use the written form of Punjabi (Gurmuckhi) whereas
Punjabi/Urdu speakers from Pakistan use written Urdu. It is important to be aware of
this distinction when seeking interpreters or translations.

Chinese speakers may use one of several forms of spoken Chinese which is significant
when seeking an interpreter. Written Chinese however remains the same.

It is useful to have a series of community language cards which can be used to find out
whether a client requires an interpreter/translations and in which community language.
Standard prompt cards are available in the main community languages at all main office
receptions.

Although it may be established that an interpreter is necessary, it should not be assumed
that translations are appropriate also. Some community language speakers may not be

able to read the language they speak.

A list of community language interpreting and translating services can be found in the
Resource List at the back of these Guidelines. The cost of the service is based on
interpreting time and travel costs and, in the case of translations, on the number of
words.

2.1.2 Hints on Providing Translations

All publications should include a sentence on the cover offering the publication in
community 1anguages and a relevant contact number for requesting a translated copy.

(see page 20)

Consult the translation service (see Flow Chart in Appendix 4) about the appropriateness
of the information to be translated. Who is the target group or individual? Would it be
better to use an interpreter or is translation required? Check also the correct language or
dialect with the Interpreting Service.



Do not use idioms, slang or colloquial terms and phrases. These are not readily
transferable into many other languages, may not carry the same meaning or message and

in some cases, may even be offensive.

Pay particular attention to terminology and ensure no terms or references are used which
may offend different cultures and religions.

Leaflet design, graphics and images should not caricature or stereotype different cultures
and religions.

2.1.3 Hints On Providing Interpreting

Ensure reception staff has sets of community language cards offering interpreter assistance
to clients/members of the public and that, reception staff know how to contact the
interpreting service promptly. If your Service requires further copies of these cards
please contact the HR Policy Team.

Ensure there is a match of language or dialect and of gender where necessary. The latter
may be particularly important for Muslim women. These questions would be answered
through 3 way telephone conversation with Language Line Services (see Flow chart)

Use only trained interpreters. Where possible, it is desirable to use an interpreter who
has knowledge of the particular subject matter e.g. housing, education etc. Once
established that interpretation or translation services are required, in the first instance,
the assistance of interpreters or translators registered with Falkirk Council should be
sought (refer to Resource List at back of Guidelines). Trained, independent interpreters
should always be used in preference to a family member or friend. This reduces the
possibility of breaching confidentiality or of placing clients or their ‘interpreters’ in a
position of embarrassment. It is obviously preferable to use a trained interpreter that the
client is familiar and comfortable with.

Meet with and brief interpreters before the interview, if possible, and establish their role.
Give him/her as much background information as possible, e.g. any specialist
terminology to be used.

Always allow extra time for an interview when an interpreter is needed. This prevents

participants becoming rushed or impatient and ensures communication is effective.

Use short sentences and allow the interpreter to interpret before continuing. Look at the
person you are communicating with and address him/her directly, rather than looking at
and addressing the interpreter.

When appropriate, allow time for debriefing with the interpreter to evaluate the session.

At least one week’s notice is normally required when booking an interpreter although in
most cases emergency requests can be met very quickly. Further information on good
practice in using an interpreter can be found at Appendix 2 Engaging an Interpreter

Checklist.



SECTION 3

3.1

COMMUNICATING WITH DEAF, AND HARD OF HEARING
PEOPLE

3.1.1 Categories of Deafness:

Deaf people is a general term which includes a whole range of people with hearing losses.
A deaf person may or may not belong to the deaf community.

Deaf people is often used to describe those who see themselves as members of a cultural
and linguistic group, who use British Sign Language (BSL) as their first/preferred
language.

Deafened people is used to describe people who became deaf either as children or adults,
usually after having acquired spoken language and the hearing loss is total or profound.
Deafened people derive little or no benefit from a hearing aid and have to rely on visual
aids for communication. Deafened people often feel lost between the hearing community
and the deaf community.

Hard of hearing/partially hearing people: are people who have a mild, moderate or
severe hearing loss which may have developed gradually or suddenly. A hard of hearing
person may have some useful hearing and will usually communicate through speech, with
or without a hearing aid and lip-reading.

The majority of deaf people are in the hard of hearing category.
8.7 million people in the UK are affected by deafness.

The majority (6 million) are aged 60 years and above.
Approximately 50,000 deaf people in the UK use Sign Language.
3.1.2 Methods of Communication

Sign Language British Sign Language (BSL) is the first language of many
profoundly deaf people and is mainly used by people
who are born severely or profoundly deaf or who
became deaf before acquiring speech. BSL is a rich and
complex visual language with its own grammar and
idioms and is quite different from spoken languages
using precise hand shapes, lip movements, facial

expression and body movement to convey meaning.

Lip Reading - Some deaf people lip-read when communicating. Some
hard of hearing and deafened people also lip-read. Some
combine the use of a hearing aid with lip-reading. It may
be necessary to use a trained lip-speaker to facilitate
communication with someone who lip-reads (see
Resource List for contacts at Appendix 1). Lip-speakers
produce clearly the shapes of words, the flow, rhythm
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and phrasing of natural speech using facial expressions
and natural gestures.

Text - It is important to apply the principles of plain English

when producing text which will be read by deaf people.

3.1.3 When Communicating Orally with Someone Who Lip-Reads

¢

Make sure you are in front of or fairly close to (approx. 3 — 6 ft), and on the same
level as the deaf person.

Position yourself with your face to the light and avoid placing yourself in front of a
bright window so that your face can clearly be seen by the lip reader. The light should
not shine directly in to the eyes of the lip reader and the speaker’s face should not be
in shadow.

Check that background noise is kept to a minimum.

Do not shout or raise your voice to a hearing aid user as this distorts the sound and
may cause actual pain to the listener.

Speak clearly, maintaining a normal rhythm of speech. Do not slow speech down or
over-emphasise words as this distorts the lip pattern.

Remember that sentences and phrases are easier to understand than isolated words.

If a word/phrase is not understood, use different words with the same meaning —
rephrase, e.g. what is your address? /where do you live? /where is your house? Some
words are easier to lip-read than others and may make more sense to the listener.

Allow more time for the person to absorb what you have said.

Keep your head still and stop talking if you turn away.

Keep hands, pens, cigarettes, etc. away from your face while speaking.

Do not eat while speaking.

Avoid exaggerated facial movements, grimacing or inappropriate facial expression.
Gesture can be helpful.

If the deaf person is accompanied by a hearing person, avoid conversing only with the
hearing person and ignoring the deaf person.

Make sure the deaf person is looking at you — attract attention if necessary.

If the topic is changed, make sure the deaf person knows.



Note: it is difficult for a person who relies on lip-reading to understand a person who has
a beard and/or moustache.

3.1.4 When Communicating With Someone Who Uses Sign Language
You will need to arrange for a trained Sign Language Interpreter to be present (see
Resource List for contacts as in appendix 1 ). Make sure the deaf person knows that a

Sign Language Interpreter will be present and that they are comfortable with the
arrangement. This should be done either in writing or by text phone/minicom.

¢ Contact the interpreter with client’s consent with any useful information before the
appointment/meeting. If you are unsure about the kind of information required
consult the interpreter. It is recommended that accredited Interpreters are used to
avoid potential breaches of confidentiality.

¢ Book more than one interpreter if the assignment is of a formal nature and lasts more
than one hour. Allow regular breaks, as it is physically and mentally demanding for an
interpreter to work for more than 40 minutes.

¢ Make time to discuss the interpreter’s role before the start of the
appointrnent/ meeting if you are unsure of how to use a Sign Language Interpreter.

¢ Arrange seating before the appointment/meeting begins.

¢ Speak directly to the deaf person, not to the interpreter during the
appointrnent/ meeting.

¢ Make sure the deaf person and the interpreter can see each other.

¢ Try to make sure there is no background noise to allow the interpreter to hear what
is being said.

¢ Avoid using jargon.If unavoidable explain any specialist words.
¢ Remember the interpreter will interpret everything that is said or signed.

¢ Do not allow more than one person to speak or sign at the same time.

Family members or friends should not be used to interpret. Interpreting is a professional
role which cannot be carried out by any hearing person who can sign. Using a relative or
friend can result in distorted or inaccurate information being conveyed and breaches of
confidentiality.

3.1.5 Communicating with Deafblind People

Some people have combined sight and hearing loss. There are approximately 23,000
deafblind people in the UK.

Communication methods vary greatly according to the amount of residual sight and
hearing. Some people will be able to hear speech, lip-read or use sign language. Many of



those who can’t hear speech or see sufficiently to follow lip-reading or sign language will
use some form of tactile communication. This includes:-

. The Deafblind Manual Alphabet. This is an adapted form of the two handed
finger spelling alphabet taken from British Sign language (BSL), the language of
the Deaf community in the UK. Words are spelt out letter by letter onto the
deafblind person’s hand.

. The Block Alphabet. The hearing person uses the tip of their forefinger to spell
out each word in block capitals on the receiver’s palm. This method is most often
used when communicating with members of the public, shop assistant and others
who are unlikely to be familiar with the Deafblind Manual Alphabet.

. Hands-On-Signing. Some people who were born deaf and then experience sight
loss in adult life may continue to use sign language even when they can no longer
follow visual signs. This is possible when the listener touches the hands of the
person who is signing and follows the movements in this way.

Deafblind communicators should be used to facilitate face to face communication with a
deafblind person (see Resource List as in Appendix 1 ). Make sure you confirmed the
preferred method of communication with the client before booking the interpreter.

3.1.5 Technical Aids to Communication
3.1.5.1 Telephone Communication

People who are hard of hearing may have a telephone with an amplifier which can be
adjusted to give appropriate volume. People who are profoundly deaf will use a text
telephone (minicom) which has its own phone line. This comprises a keyboard and small
screen. A number of Council offices are equipped with a minicom (see Resource List for
Council minicom numbers as in Appendix 1). Deaf people may also use a fax or email
to communicate. Where a Council office does not have a text phone an ordinary
telephone can be used to communicate through Typetalk, a BT/RNID service which
relays what you say by converting the message to text on the customer’s minicom.

3.1.5.2 Induction Loop Systems

Induction Loop Systems have been fitted in Council reception areas and in some meeting
rooms and entertainment venues. They allow people with hearing aids to tune in to what
is being said without the interference of background noise. A loop system comprises a
loop of wire, an amplifier and either a microphone or direct connection to a sound
source. Hearing aid users switch their hearing aid to the “T” position to tune in. It is
important to display the nationally recognised sign to let customers know a loop is in

place.
3.1.5.3 Speech-To-Text Transcription Services
Speech-to-text transcription is particularly useful at meetings, conferences and lectures

where it is difficult to lip-read. An operator uses a keyboard to convert what is said into
text. This text then appears immediately on a computer monitor or large screen. A hard



copy of the text can be printed out, in type or Braille, depending on the equipment used.
There are two main types of speech-to-text transcription:

3.1.5.4 Palantype

Can only be used by trained operators who use a special phonetic code system to reach
speeds of up to 200 words a minute. Because Palantype is so fast, the deaf person will
receive a verbatim record of what is said on their screen.

3.1.5.5 Hi-Line

Anyone who can type can, with a bit of training, operate a Hi-Line system. If the text is
available in advance, it is possible to produce a simultaneous verbatim version.
Otherwise, a summary of what is being said will appear on the screen.

3.1.5.6 Note takers

When you are concentrating on lip-reading or following sign language, it is virtually
impossible to take notes at the same time. Note takers sit in on meetings, lectures or
conferences and take notes on behalf of the deaf or hard of hearing person. A note taker
can often be used in conjunction with other communication support, such as a sign
language interpreter. That way a deaf person can take an active part in a meeting and
have an accurate record of everything which is discussed.

(For all the above contact the Sensory Centre at 01324 590 888)
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SECTION 4

4.1

COMMUNICATING WITH PEOPLE WITH A VISUAL
IMPAIRMENT

4.1.1 General Information

Approximately one person in sixty is blind or partially sighted. This means that there
may be over 2,400 people in the Falkirk Council area with some form of visual
impairment. Many more people have problems reading small print or badly designed

documents.

Two thirds of visually impaired people have lost their sight as a result of an age—related
eye condition. But there are visually impaired people in every age group.

Four out of ten visually impaired people rely on someone else to read some of their
information to them. This does not have to be the case and most visually impaired people
could be more independent if information arrived in a format they could read.

Very few visually impaired people see nothing at all.  Print is therefore the most
appropriate medium for most (more than six in ten) visually impaired people. Good,
clear, legible print is neither difficult nor expensive to produce.

Now that cheap audio tape records are available many more people are using this to send
and receive information. Tape is also useful for those who cannot read for educational,
cultural or medical reasons. Deafness does however limit its suitability among older

people.

Braille is used by a relatively small number of blind or partially sighted people. However,
it is an important medium for those who can read it. Many blind people also know
enough Braille to find it helpful on signs for example in lifts..

Falkirk Council has a Braille printer, which converts text held on disk in to Braille. If you
require the use of this please contact Sensory Centre at 01324 590888

4.1.2  When Communicating With Someone Who Is Blind or Partially
Sighted

During face to face communication with a blind person it is important to maximise the
use of verbal communication. The person will obviously not receive the same amount of
visual information as those with sight. Information about layout, other people present and

who is speaking/being spoken to must be provided through verbal communication.

At meetings or appointments with a blind person:

¢ Introduce yourself by name and job title.

11



¢

Do not speak directly to the person — you may need to touch the person on the arm
to make them aware before you start to speak or address them by name before

speaking.

Guide someone to the office or meeting room by offering your arm (this may not be
necessary if the person has a guide dog). Do not push the person, guide them from in
front.

Explain the layout of the room, furniture etc.
Ensure that other people present are introduced.

Ensure the person is aware of who is speaking, particularly if several people are
involved in a meeting.

Do not allow more than one person to speak at a time.

4.1.3 Hints on Producing Clear Print

It is important to understand that visually impaired people can have different types of eye

conditions this means that what they can see differs greatly from person to person. It is

impossible to set down a print standard that will meet everyone’s needs. However, the

following guidelines do describe a few inexpensive steps that can easily be taken to

improve the legibility of all documents we produce.

¢

Good contrast is important when considering print legibility. Contrast is affected by,
paper type, paper colour, printing inks, type size and weight. Black type on white or
yellow paper gives very good contrast. Avoid pale colours on coloured backgrounds
and never use yellow printing inks — they are as good as invisible to people with a
visual impairment.

Reversing type (white text on a black background) is an acceptable way of
emphasising titles, provided the typeface and size are not too small .

The type size you choose can greatly improve the legibility of documents. The RNIB
recommends that documents for general readership should be at least 12pt. It is
recommended that the minimum type size to be used in material intended for visually
impaired people is 14pt. Some people prefer 16pt or even larger sizes. Sizes greater
than 20pt are not generally recommended.

Light typefaces should not be used. Use medium or bold type weights.

Serif faces are preferable to sans-serif faces in continuous text. However, some texts
may appear smaller than others when produced in 12 pt. In this case, the font size
should be increased to 13 or 14 pt.

The RNIB includes Garamond and Helvetica in its list of clear typefaces. The choice
of typeface is less important than size, contrast and the way in which characters are

spaced.
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Use only left justified ‘ragged’ lines of text. Right justification or margins should be
avoided.

Avoid splitting words at the ends of lines.

Glossy paper can be difficult to read, so avoid using it. Very thin paper can also cause
problems with text showing through.

Capital letters are harder to read than lower case letters because words are
recognised by shape not by individual letters. So avoid using continuous capital
letters in words.

Leave space between paragraphs. Avoid fitting text round illustrations.

Blocks of capitals underlined or italicised text are all harder to read. A word or two
of capitals is fine but avoid the use of capitals for continuous text. Underlining text or
setting it in italics should always be avoided. An alternative method to emphasise text
is to make it bold.

4.1.4 Hints on Producing Audio Tape

Tape is an important and growing way of providing information to Visually impaired

people, but it has its limitations. Taped documents are, for example, not easy to refer to

during a meeting, and it can be difficult to find your way around a document.

Tapes can also be helpful for people who have dyslexia.

Tapes can be produced professionally from text at reasonable cost (see Resource List at

Appendix 1).

¢

If recording material yourself use an external microphone and try not to have to hold
the microphone. Sit facing the centre of a room instead of facing a wall.

Start your recording by clearly stating what the document is, what it is for and how
long it is.

Read clearly but not too slowly and vary the tone of your voice to make it sound

interesting.

Pause briefly at the end of paragraphs and sections.
Correct mistakes as you go along by taping over them.
Spell out important or unusual words.

If tables must be used keep them short and simple. It might be better to just describe
the main points rather than have them illustrated by a longer table.

Remember to label your tapes.

13



4.1.5 Hints on Producing Braille
Braille is a tactile form of writing using raised dots.

Braille has eight words per line on average and is much more bulky and heavier than
printed text.

Numbering of sections, indents, headings, paragraphs and lists is important because
Braille is more difficult to scan than print.

Braille pages are always numbered in the top right hand corner.

Always include a contents page at the beginning of the document to help the reader get a
quick idea of the document’s structure and contents.

Braille material can be produced at the Sensory Centre (see Resource List as in appendix

1)
4.1.6  Other Technologies

Computer systems are owned by a relatively small number of blind and partially sighted
people. While making information available on computer disk may improve matters for
some, it is not the solution to meet all needs.

Telephones can provide a good way of communicating with visually impaired people.
Three quarters of visually impaired people own a telephone. Information can be
provided over the telephone on a one-to-one basis or via recorded messages. The biggest
advantage of the telephone is that access to information is immediate. This is an
important point for visually impaired people because much of their information is often

delayed by the need for special production.
4.1.7  Signs and Symbols

The purpose of signs and symbols is to convey information clearly and concisely at a
glance.

Signs are especially important to people who have difficulty communicating verbally and
those who cannot speak English. People are normally expected to ask for directions or

other information such as opening times, if not already known.

Signs are particularly important to indicate, for example, that an induction loop system is
available.

4.1.8 Designing and Placing Signs

Signs should be clear and legible, easy to distinguish from the background and consistent,
i.e. using the same format (colour contrast, light and text font and symbols used).

Text should be backed up by universally recognised symbols, this will assist those who do
not read English or who have a learning disability.

14



Text should be a mixture of upper and lower case letters, since words are recognised by
shape and not by individual letters. Never use block capitals. Use plain language at all

times.

Letters, numbers and symbols should be at least 70mm high for internal signs and be in a
bold, simple typeface. Helvetica Bold is the typeface that most airports, railway stations
and bus stations use for signs.

The surface of the sign should be non reflective and well lit.

Colour contrast between the sign background, sign face and text is more important than
colour in the legibility of signs to visually impaired people. This is because of the
sensitivity to any particular colour varies according to the disabling eye condition.

Combinations of red and green should be avoided however, since these are commonly
confused by 9.3% of the population who are colour blind. White or yellow lettering on a
dark background is recommended as this avoids glare.

Signs should be visible from both a seated and standing position — ideally 1400mm above
ground level. Where these are likely to be blocked, e.g. by people standing, signs should
also be provided above head height (minimum 2100mm clearance).

Signs should be located consistently throughout a building in the same colour and format
for consistency and to avoid confusion, so people know where to look to find the
information they need. This is especially important for people with visual impairment.

Braille, raised letters, numbers and symbols should be used on low level signs. However
this is only effective where people with visual impairments know where to look and can

find the sign.

There are very few blind people who are proficient users of Braille and it is more difficult
to read when set on a vertical plane, i.e. in the case of a normal sign. Therefore it is
better to restrict its use to a few letters or numbers in obvious locations such as beside
controls, e.g. lifts, door numbers or at the end of handrails to indicate floor levels.
Raised numbers and symbols should be used in the same way, being useful to people with

visual impairment who cannot read Braille.

Further information about signage is availablehi@ €ouncil’'s Inclusive Design Guide. Copies
can be obtained from the HR Policy Team.

Advice on graphic design and accessible print is available from
Communication Unit, Corporate & Commercial services.

All Council publications are available on request on tape, in large print or in
Braille. Please contact the Communication Unit in Corporate & Commercial
Services

Tel: 01324 506056

Approved design templates for signage are included in the Council’s

corporate identity manual, copies of which can be obtained from the
Communication unit, Corporate & Commercial Services.
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SECTION 5

5.1  WEBSITE ACCESSIBILITY

The Falkirk Council website was specially designed to be fully accessible by everyone,
including blind and visually impaired users.

The website follows the W3C’s Web Accessibility Initiative’s (WAI) Guidelines, allowing
easy access to the website for blind or visually impaired users, as well as users with
dyslexia, learning disabilities or low literacy levels, and for people with English as a
second language.

5.2 ACCESS KEYS FOR KEYBOARD NAVIGATION

The website supports the use of access keys, which help you to navigate the site using
keyboard shortcuts.

There are a number of keyboard shortcuts available on the site to help you to navigate

around more easily. By using the relevant combination of keys you can quickly move
between the main areas of the site.

The following access keys have been defined for the web site.

0 0 — Accessibility

O 1 —Home page

0 2 — About Council

O 3 —Services

O 4 —The area

O 5-AtoZ

0 6 — Contact us

0 7 —Sitemap

0 8- Help

O 9 — Terms and conditions

0 L — Listen to the site using the ReadSeaker XT software

To use an access key, PC users use the ALT key and press the appropriate number or
letter as defined in the list above. Mac users use the Control (CTRL) key and the
appropriate number or letter. Once selected, you may have to press the return or enter
key to activate the link.

16



5.3

5.4

5.5

TEXT SIZE

Some people may wish to view this Web site in larger text size. To do this you will need
to adjust your browser settings:

Microsoft Internet Explorer
Select the ‘View’ menu in the browser tool bar, select “Text size’ and select your
required size - either larger or smaller.

Mozilla family browser (Firefox etc)
Select the ‘View’ menu in the browser tool bar, select "text size" then choose to
either ‘Increase font or ‘Decrease font’ until the text is the required size.

You can also use the following keyboard shortcuts:

0 Increase text-size: Ctrl +

0 Decrease text-size: Ctrl -

CHANGING COLOURS

Changing the site’ background colour can be particularly useful for users who rely on
magnification technology as white can produce an uncomfortable glare.

It is also possible to Change the colour of body text on the site. Both can be achieved by
changing preferences in your browser:

Microsoft Internet Explorer

Select the “Tools’ menu, select ‘Internet options’, select ‘Colours’ and make
changes to text and background colours in the colours panel. Then choose the
‘Accessibility” button and tick the box labelled ‘Ignore colours specified on web.

Mozilla Family Browser (Firefox etc)
Select the “Tools’ menu, select ‘Options’, open the ‘Content’ tab and select
‘Colours’. You can define the colour of text and background from here.

LISTENING TO THE WEBSITE USING READSPEAKER XT

Users can choose to have the website read to them using ReadSpeaker XT software. This
function allows blind or visually impaired users to access all the available information on
the website by allowing the ReadSpeaker software to read the content aloud to them.

This function can be accessed as follows:

Find the page you want to have read to you then click on the listen icon at the top of the
page, or use access key ‘L’. This will automatically open up the ReadSpeaker XT
software. You can then choose whether to ‘Read text’, ‘Read links’ or ‘Stop’. The
settings can also be amended so that the speed and volume of the audio can be adjusted to
suit your preference. A text-only version is also available, and the colour of the text and
background can still be changed to suit your needs.
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5.6

5.7

5.7

5.8

VIEWING PDFs (PORTABLE DOCUMENT FORMAT)

Many of the Council’s leaflets and application forms are available on the site for
downloading. Most of these documents are in PDF format, which means they can only be
viewed using Adobe Reader. This software is available free of charge from the Adobe
Web site.

Adobe offers useful resources and tools to aid the accessibility of PDFs; these can be
accessed via the Access Adobe website. There is also an online conversion tool for PDFs.

LISTENING TO PDFs — READ OUT LOUD

The latest version of Adobe Reader, version 7, comes with the ability to read the PDF
content to you. This function, known as ‘Read out loud’, can be accessed as follows:

Open the PDF you want read to you in Adobe Reader 7, go to the ‘View’ menu and
select ‘Read out loud’. You will then have the option to ‘Read this page only” or ‘Read to
end of document’.

REQUESTING PDFs IN ANOTHER FORMAT

If you do not have access to Adobe Reader software and would like to receive one of our
PDF files in a different format, such as a plain text file, please email the Web team, who
will convert the PDF into your preferred format for you.

RELATED INFORMATION

Falkirk Council website: www.falkirk.gov.uk
Download Adobe Reader:
www.adobe.com/products/acrobat/readstep2 allversions.html

Access Adobe website: www.adobe.com/accessibility/index.html

Adobe’s online conversion tool for PDFs:
www.adobe.com/products/acrobat/access onlinetools.html

Or email the Web Team for more information: webteam(@falkirk. gov.uk
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SECTION 6

6.1

INCLUSIVENESS OF DIVERSITY AND DISABILITY

People respond better when they feel included. If you’re writing to or for Council service
users, address them directly using person-centric language that does not alienate people
on the basis of gender, age, sexual orientation, disability, race, religion or ethnicity.

6.1.1 Gender

* Our use of language should reflect not only changes in society but the Council’s values.
Phrases such as career girls, businessmen, housewives and male nurses, for example,
are outdated, patronising and reinforce outdated stereotypes.

* Remember to refer to fire-fighters (not firemen) and PCs (not WPCs). If you need to
use an adjective, use ‘female’ and not ‘woman’ in such phrases as female president or
female MPs.

* Use ‘humankind’ or ‘humanity’ rather than mankind.

* Never say ‘his’ to cover men and women: use ‘his or her’, or a different sentence

construction altogether.

6.1.2 Age

* Do not use the term ‘elderly’ to describe anyone under 70.

* Say ‘elderly people’ (or, even better, ‘older people’), never ‘the elderly’, ‘OAPs’ or
‘old age pensioners’.

6.1.3 Sexual orientation

* The terms ‘homosexual’, ‘gay’, ‘bisexual’ and ‘heterosexual’ should be used as
adjectives, not nouns: a gay man, gay people, gay men and lesbians; not ‘gays’ or
‘lesbians’.

6.1.4 Disability

* Use the term ‘disabled people’ not ‘people with disabilities’ in line with the social
model of disability that locates the discrimination in the barriers created by society,
rather than in the disability itself.

* When referring to someone’s impairment, use person-focussed wording to avoid
defining people by their medical condition. Don’t use generic labels for groups of
disabled people, such as ‘the blind” or ‘the disabled’. Instead, try to emphasise the
person not the impairment and say things like ‘deaf person’, or ‘disabled people’,
‘children who are blind’ rather than ‘blind children’ and ‘someone with epilepsy’, not
‘epileptic’.

* Use positive language about disability, avoiding outdated terms that stereotype or
stigmatise. Terms to avoid, with acceptable alternatives in brackets, include:

* victim of, crippled by, suffering from, afflicted by (person who has, person with)

* wheelchair bound, in a wheelchair (uses a wheelchair)
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* invalid (disabled person)

* mentally handicapped, backward, retarded, slow (person with learning difficulties)

* the disabled, the handicapped, the blind, the deaf (disabled people, blind people, deaf
people, sensory impaired people)

* deaf and dumb (deaf and speech-impaired, hearing and speech-impaired, sensory
impaired people)

* dumb (speech-impaired)

* dyslexic (person with dyslexia, person who has dyslexia).

6.1.5 Mental health

* Take care using language about mental health issues. Do not use terms such as ‘victim
of’, ‘suffering from’, and ‘afflicted by’ because they stigmatise. Instead you should say
‘a person with’.

* Do not refer to ‘the mentally ill’, “mentally handicapped’, ‘mentally retarded’ (say
‘mentally ill people’, ‘mental health patients’ or ‘people with mental health
problems’).

* The terms schizophrenia and schizophrenic should only ever be used in a medical
context, and never as a noun.

6.1.6 Race and ethnicity

* When describing groups of people, consider what type of labels you’re using and
whether they’re consistent. For example, you cannot compare the Black community
with the Muslim community, as this is comparing a race with a religious group.

* Names of ethnic groups (ie those recognised as an ethnic group under the Race
Relations Act) should always begin with a capital letter. This includes Gypsy, Traveller
and Irish Traveller.

* The words ‘black’ and ‘Asian’ should not be used as nouns, but adjectives: ‘black
people’ rather than ‘blacks’, ‘an Asian woman’ rather than ‘an Asian’, etc.

* Do not use ‘ethnic’ to mean black or Asian people. In a British sense, they are an ethnic

minority; in a world sense, of course, white people are an ethnic minority.

* Avoid the word ‘immigrant’, which is very offensive to many, not only because it is
often incorrectly used to describe people who were born in Britain, but also because it
has been used negatively for so many years.

* Say African-Caribbean rather than Afro-Caribbean.
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APPENDIX 1

Resource List
1. Community Languages - Interpreting And Trans]ating Services

An interpreter can be booked by contacting the following agencies. Text can also be
translated by these agencies into community languages.

Community Outreach Team
Dundee City Council
Central Library

Wellgate

Dundee

DD1 1DB

Tel: 01382 435825

Glasgow City Council
Interpreting Service
Tel: 0141 276 6850

2. Sign Language Interpreting
The Council Sign Language interpreting. Contact:

Forth Valley Sensory Centre
Redbrae Road

Camelon

Falkirk

FK1 4DD

Tel: 01324 590888

Fax: 01324 590889

Email — sensory@falkirk. gov.uk

Please note that for Council services, there will be no charge for Sign Language Interpreting.
However, the following agencies will apply a charge

Other agencies, which can arrange sign language interpreting services, are:
RNID (Royal National Institute for Deaf People)

Tel: 0845 685 8000

Edinburgh & East of Scotland Deaf Society
Tel: 0131 556 3128
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Lipspeaking/Deafblind Communicator

Lipspeakers and Deafblind Communicators are provided through Forth Valley Sensory
Centre free of charge.

Large Print

Large print copies of documents can be printed directly from a PC (14 point size text or
larger) by the Communications Unit, Corporate & Commercial Services, Municipal
Buildings, Falkirk. Tel: 01324 506056

Braille

Braille copies of documents can be produced by the Sensory Centre. Send the document
in WORD format on disk to the Sensory Centre to have it converted in to Braille. Tel:
01324 590888.

Audio Tape

Audio tape copies of documents can be produced by Forth Valley Talking Newspaper.
Contact:

Christine Moroney
Tel: 01324 812082

Further Information

For further advice regarding communication requirements contact:
HR Policy Team
Municipal Buildings
Falkirk
Tel: 01324 506012

* no cost to Services which jointly fund the Council’s interpreting service
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Communication Aids within Falkirk Council

Minicoms (Or Text phones)

Callendar Square One Stop Shop 01324 506920
Grangemouth One Stop Shop 01324 504534
Grahamston Social Work Office 01324 501799
Bo’ness Social Work Office 01506 778652
Stenhousemuir Social Work Office 01324 503535
Meadowbank Social Work Office 01324 718055
Camelon Social Work Office 01324 501202
Environmental and Consumer Protection Services 01324 504455
Forth Valley Sensory Centre 01324 590888

Note: Any Council office which does not have a minicom can still communicate with a
minicom user by using the BT/RNID relay system Typetalk. The operator will relay
what you say by typing it out so that it appears as text on the users minicom.

To access Typetalk dial 0800 515152. The Council’s account number is 790926 and you will be
asked to quote this at the start of your call.

Print Enlarger

A CCTV print enlarger is available for use by the public in the reference section, 2" floor, Falkirk
Library, Hope Street, Falkirk.

Infra-Red Sound and Amplification System

As well as being fitted with an induction loop, Falkirk Town Hall has an infra-red system for
people who are hard of hearing but do not wear a hearing aid. Headsets are available from Town
Hall staff. For further information contact the Venue Manager, Tel: 01324 506174.

Suggested Statement for Inclusion in Council Publications

If you would like a copy of this booklet/leaflet/document in community languages, Braille, large
print or on audio-tape telephone ------ (insert contact number of person responsible for the

document. Give a fax or minicom number as well).

(This text states, in Urdu, Chinese, Polish and respectively, that the document (Title of the
document should also be mentioned) is available in community languages).

Title of the Booklet/Leaflet or brief description of the document in English and in
the formats on offer. e.g. How to pay your Council Tax, title would be sufficient
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APPENDIX 2

Engaging an Interpreter, Checklist

1. Identify the need:

* Identify the exact language your client need

*  Check the Interpreter’s gender appropriateness with your client

* Beaware of any cultural difference that could jeopardise the success of your meeting

(time and venue for your meeting)

2. Briefing time:

Allow 5 — 10 minutes to brief the interpreter on the assignment and for the
interpreter to meet the client and confirm language match

3. Cultural Difference:

Check with the interpreter of there is any cultural difference/sensitivity that you
should be aware of prior to the meeting

4. Seating Arrangement

Ask the Interpreter for the best arrangements for them to achieve the best of their
work

5. Communication
Always address the client directly
Speak clearly and at a convenient pace and volume
Avoid the use of jargon as much as possible

6. Interpreter’s rights

Allow the interpreter to interrupt at any time during the meeting in order to:

*  Ask for clarification
*  Object on the communication’s length and speed

. Clarify misunderstanding
Allow for breaks if the meeting is too long

7. Your rights
Take control of the meeting and use the interpreter as aof
passing on the information only.

8. Don’ts
a. Do not ask the interpreter for an opinion during the meeting:
b. Do not rely on the interpreter to explain details of your work:

c. Do not forget: Interpreters are only there to interpret what is said between you
and your client:
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APPENDIX 3

Guidelines for Hsing a Sign Language Interpreter

Speak directly to the deaf or hard of hearing person

The interpreter is a professional who is there to facilitate communication between the two
parties. There is no reason to ask the interpreter to tell something to the deaf person.

Speak as you normally would, in a moderate rhythm.

Use normal facial expressions and voice tones.

Locate the interpreter in front of the deaf person so that they can both see each other clearly

Do not have the interpreters back to a window as this would mean that the deaf person is
looking into the light. This would not allow him to see the facial expressions or the hands of
the interpreter clearly.

If possible have the interpreter’s back to a blank wall; patterned curtains or wallpaper can

cause visual noise.

Ensure that there is good lighting in the room as this can aid communication.

Ensure that if there is more than 3 people in the room that it is made clear at the start of the

session that only one person speaks at any one time.

Confusion takes place if more than one person talks simultaneously or if people interrupt one
another

Do not say anything that you don’t want interpreted — an interpreter is ethically bound to
interpret everything that is seen or heard.

Remember that the interpreter is a few words behind the speaker. Allow the interpreter
time to finish the message before asking questions or starting a discussion.

At times the interpreter may need to interrupt the speaker or signer to ask for clarification.

Avoid jargon, but explain any specialist words, which can not be avoided.

Interpreter Requirements

If this were a specialist assignment i.e. Court or Legal work, it would be appropriate to book
an interpreter with the right experience, qualifications and of the appropriate sex for the

assignment.

Negotiate rest breaks with the interpreter — this should be approx. every 20 — 30 min. If a
session is to last more than 2 hours then 2 interpreters may be required.

If possible, give the interpreter some information about what they are going to interpret
before the assignment. This will allow the interpreter to prepare for the assignment. If due
to patient confidentiality this is not possible then discuss the proceedings before the

interpreter enters the room.

Have water available for the interpreter.
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Appendix 4

How to Access Interpreting Services for Falkirk Council

Ethnic Minorities

Sign Language BSL, Lip o o
speaking rasnscgptlon
Deaf blind Manual ervices
Contact: Available through
Braille, Tape or
Sensory Centre to book CD

an interpreter

Sensory Centre: 01324 590888

Dundee City Council: 01382 435825
Language Line Services: 0800 169 2879

Sign Language Interactions (SLI) 07970 848868
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Telephone
Interpreting

Interpreting
Service

Translations

Contact:

Dundee City Council

For more information and advice contact:

HR Policy Team: 01324 506012




